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Overview 

Intact Analysis using Byos by Protein Metrics analyzes mass spectra of intact (undigested) proteins. 
Features include: 

1. Support for all major mass spectrometry instruments and vendors 

2. Automatic or manual chromatographic time windows 

3. Deconvolution of charge states to transform m/z spectra to neutral mass spectra 

4. Automatic mass peak picking and intensity calculations 

5. Side-by-side comparison of multiple samples 

6. Reporting of summary data and figures 

Note that standalone applications are no longer supported outside of Byos and that Intact Analysis is 
included in Byos workflows.  

Introduction 

An intact mass spectrum of a protein sample provides a direct test of protein sequence, truncation, 
extension, glycosylation, and purity. For example, Figure 2 is a deconvolved mass spectrum from the m/z 
plots shown in Figure 1 below. The neutral mass peaks in a deconvolved mass spectrum represent protein 
forms (“proteoforms”) in the sample. 

 

Figure 1: Summed MS1 scans of Adalimumab. The peak cluster around m/z 2963 shows the protein with 
charge z=50+ and the cluster around m/z 3023 shows charge z=49+. 
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Figure 2: Intact mass spectrum of Adalimumab. The neutral mass spectrum is computed by 
“deconvolving” the charge states from the summed m/z spectrum in the previous figure. Each peak in an 
intact mass spectrum represents a “proteoform”. For example, the largest peak at 148,083 is Adalimumab 
with two G0F glycans, which has a calculated average isotopic mass of 148,084 Da. The small peak at 
146,637 represents the mAb missing one glycan. The inset shows the neutral mass spectrum before 
(gray) and after (black) peak sharpening. 

Intact Analysis typically employs a short (10 to 20-minute) liquid chromatography (LC) gradient. LC helps 
separate proteins (for example, the heavy and light chains of a reduced mAb). Even when the sample 
contains only a single protein, LC gives cleaner spectra than direct infusion. 

Protein Metrics Intact Analysis software first divides the LC profile into trace peaks. After reviewing the 
summed m/z spectra, the user can adjust the trace peak chromatogram to add, remove, split, or merge 
trace peaks. The m/z range and output mass range can be set for each trace peak. Alternatively, the 
software’s default settings can be applied over the full range of m/z from 600 to 9000 and all masses 
between 10,000 to 160,000 Da. The peak-picking algorithm finds the most intense mass peaks in the 
deconvolved mass spectrum and reports them in the Masses table. Mass peaks can be added, removed, 
and annotated. For example, in the spectrum in Figure 2, the mass peak 148,039 Da may be considered 
indistinct and then manually removed. Similarly, the small peak at 148,373 Da (middle peak in the inset) 
may be added and annotated as “G0F/G1F + Lys”. A mass peak can be evaluated by selecting the 

mass peak and inspecting the corresponding m/z peaks, as shown in the figure below. 
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Figure 3: Dots connect neutral masses to m/z peaks. The Intact Analysis software provides interactive 
views of the data; selecting a mass peak in the spectrum or Masses table colors the m/z bins that 
combine to give that mass peak. A smooth sequence of m/z dots is a sign of correctness, while an up and 
down pattern is a sign of an artifact. 

Protein Metrics’ Intact Analysis software relies on a new “parsimonious” charge deconvolution 

algorithm. This algorithm makes no assumptions about peak shapes and requires separate evidence for 
each mass peak, thereby reducing “harmonic” and “off-by-one” artifacts, which result from assigning 
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a number of charges to the m/z peak. The standard MaxEnt algorithm uses peak shape models, which can 
be helpful in the common cases (but detrimental in the less common cases) and tends to split peaks in 
order to increase the entropy of the deconvolved spectrum. With its default settings, Intact Analysis’s 
deconvolved mass spectra closely reproduce the peak shapes of the m/z spectrum. As seen in Figure 2, 
Intact Analysis also allows peak sharpening or super-resolution of mass peaks by deconvolving a 
parametrically defined point spread function. 

Windows Support 

Byos Desktop is currently supported on Windows 10 and Windows 11. Note that for Windows 10, you 
must have version 1809 or later.  

System Specifications 

• Recommended PC: 
o Windows 10/11 64-bit  
o 32 GB RAM 
o 1TB disk space (Solid State SSD) 
o Recent version of Intel Core i7 or i9 / AMD Ryzen 7 or 9 (with AVX support) 
o Oracle JRE or OpenJDK 
o C++ compiler version 16 or higher 

• Recommend PC for high performance computing (e.g. 32+ cores) 
o Windows Server 2022 or Windows 10/11 
o 64 GB RAM 
o 2 TB disk space (Solid State SSD) 
o Xeon CPU(s) (at least 16 physical cores) (with AVX support) 
o Oracle JRE or OpenJDK 
o C++ compiler version 16 or higher 

Note that standalone applications are no longer supported outside of Byos and that Intact Analysis is 
performed using Byos workflows. 

Raw mass spec data are accepted from these vendors: Thermo Fisher, Waters, Sciex, Bruker, or Agilent. 
Optical data may be embedded in these files or imported via a *.csv file of time-intensity data pairs 

Tour of Intact Analysis Views 

The user interface (UI) for Intact workflow shown in the figure below has six views: 
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Figure 4: Six Intact Analysis views: (1) Project table with input MS files, (2) Trace plot chromatogram with 
selected peak, (3) Trace Peaks table, (4) MS1 spectrum (summed spectra), (5) Deconvolved mass 
spectrum, (6) Masses table. Views can be rearranged, resized, docked, and undocked. 

1. The Project view lists the data files in use. R project is a reference project, M project is a multi-
sample project and C project is a comparison project. The Show trace and Show peaks check 
boxes can be used to turn on or off Trace plot and Trace Peak table records in Views 2 and 3. 

2. The Trace plot shows the total ion chromatogram (TIC), base peak intensity (BPI), ultraviolet 
(UV) trace, or electropherogram (iCIEF). Electropherograms are read when using the icIEF-MS 
workflow. When an electropherogram is loaded, radio buttons appear to enable a switch of the X-
axis units from Minutes to Isoelectric point (pI). The chromatogram of a purified protein typically 
has a small number of trace peaks. In this example, there are two trace peaks, only one of which 
(the highlighted peak in the center)contains a strong signal for the intact biotherapeutic protein 
Adalimumab. The leading and trailing edges of a trace peak may contain different mixtures of 
“proteoforms”.  

3. The Trace Peaks table summarizes the Trace plot chromatogram or electropherogram. Selecting 
a row in the table selects a peak in View 2. Trace peaks can be merged, split, added, or deleted 
using the buttons at the top of View 2. Time limits can be adjusted by editing text in View 3 or 
dragging the magenta bars shown in View 2. 

4. MS1 shows the summed m/z plot for the chromatogram or electropherogram trace peak selected 
in Views 2 and 3. Except for summing individual scans, this spectrum is unprocessed. 

5. The Deconvolved Mass spectrum is the primary output of the software. Neutral masses are 
plotted for the summed m/z plot (View 4) associated with the trace peak selected in Views 2 and 
3. Hollow dots indicate picked peaks, the “candidate” masses that can be assigned for reporting. 
Once assigned, the dots become solid green and peaks become persistent. Outlined and colored 
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dots show interactively selected peaks, connecting to the corresponding colored dots in the m/z 
plot. 

6. The Masses table includes one row for each picked peak from View 5. The user can add, delete, 
or assign rows in the table. The name of a mass peak can be either its mass or an interpretation. 

7. An additional Mass XIC view can be enabled within the Windows tab. See the Mass XIC section 
for more information.  

Project Creation using Intact, Reduced, ADC, and icIEF-MS 
Workflows  

The following section is relevant to analyses based upon the Intact, Native Intact, Reduced, ADC, and 
IntaBio icIEF-MS workflows. These workflows all have the Samples, Proteins and masses, Sample-protein 
input and Processing nodes tabs. The default parameters to review are included within the Sequences 
and masses and Processing nodes tabs. 

Samples Tab 

MS sample files are added in the Samples tab. Intact Analysis accepts a variety of reference sample files 
(Bruker: *.d, Thermo: *.raw, Waters: *.raw, Sciex: *.wiff, Agilent: *.d) as well as csv-type files 

starting in Byos v5.0. To enter a file, drag and drop an MS file into the project window. Alternatively, click 

Add sample, double-click in the MS file column, click  and browse to the sample file. Click Open. 

 

Figure 5: Adding samples and their traces in the Samples tab 

The sample is named for the file name; to change the sample name, click the default name twice and enter 
a new sample name. Click Add sample(s)... on the left to add a new row to the Samples table. Then add 
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the desired files as above. To remove an unwanted sample file row, select the row and click Remove 
row(s). 

The MS file populates both the Samples table and the Traces table at the bottom. Selected (not checked) 
traces can be removed by clicking Remove trace(s). Removed traces can be restored by clicking Add 
missing traces…, check the trace to restore and click OK. To associate specific traces to the samples, 

double-click the text in the Selected samples column, then click the  button to open the Edit samples 
selection dialog: 

  

Figure 6: Edit samples selection dialog to associate traces with sample names 

To associate the selected trace with an individual sample, uncheck All samples, check a single sample, 
and click OK. Note that multiple checked samples are not supported for traces.  

Individual traces can be imported from sample file types supported in the MS file cell, as well as *.csv, 

*.txt files, and *.itb. To import a trace from a file, drag the file into the Traces files column in the 

Samples table. Alternatively, double-click in the Samples table row under the Traces file column, click  
and browse to the sample file. Click Open. The trace file is added to the sample name and the trace is 
added to the Traces table: 
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Figure 7: Traces imported from a *.csv file 

Multiple traces can be added to a sample. To add additional trace files, click in the Traces file cell, click 
the  icon and navigate to the new trace file, as before: 

 

Figure 8: Adding multiple trace files to a sample 

To remove a trace file, click in the Traces file cell to be removed and click the  icon. 
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Trace peak options 

To control how the trace peaks are processed, click Edit trace peak options at the bottom:  

  

Figure 9: Trace peak options presets 

At the bottom of the Trace peak options presets dialog are the Baseline parameters. The baseline type can 
be set to Auto or Flat. Baseline smoothing width is also set here. Larger smoothing factors will merge trace 
peaks while smaller values will split trace peaks. 

The Trace peak options presets dialog contains five default peak processing presets: 

 

Figure 10: Default trace peak presets 

Select a processing preset and edit the peak parameters. To create a custom preset, click the  button, 
add a preset name, and click OK. Next, select a creation type and edit those peak parameters. The new 

preset is added to the list. Click the  button to edit a selected preset name. Click the  button to delete a 
selected preset. 

The default and custom peak processing presets can use one of four Creation types: 

 

Figure 11: Trace peak Creation types 

These Creation types use the following peak processing methods: 

● Single Slice processes the entire trace as a single peak. 
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● Custom slice(s) divides trace peaks Custom slice(s) by user defined start and end points: 

 

Figure 12: Trace peak Custom slice option 

Click Add row and enter start and end points for each slice. To remove a slice, select it and click Delete 
row. 

● Fixed width slice(s) divides trace peaks by regular intervals defined by the user: 

 

Figure 13: Trace peak Fixed width slice(s) option 

● First slice range sets the start and end points for the first slice. This also sets the width for all 
slices. 

● Step between slices is the delta that sets the start of subsequent fixed width slices by adding 
the step value to the start of the preceding slices. For example, the values above define the first 
slice as 0 - 5, the second slice as 2.5 – 7.5, etc., through the end of the trace.  

● Number of slices sets the maximum number of defined slices. If blank, the last slice is 
determined by the end of the trace x-axis range. 

● Show Example displays an example fixed width slice configuration with definitions and 
explanations: 
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Figure 14: Fixed width slice Usage example 

● Compute peaks automatically determines the trace peaks based on their minimum width, after 
smoothing: 

 

Figure 15: Trace peak Compute peaks option 

o Choose peaks, when checked, limits the detected peaks to the specified x-axis range. 
The option that contain apex within selects the whole peak of each apex within the 
specified range. The option truncated by trims the first and last peak to fit within the 
specified range. 

Starting with Intact Analysis v. 3.8, Global trace peak filters can also be applied. . To set peak property 
filters for all the traces, click Edit Global trace peak filters: 
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Figure 16: Global trace peak filters 

Check Show peaks within range to manually set start and end points. Minimum peak area sets a Normed 
area % cutoff filter. Normed area % is calculated by dividing the peak area of an individual trace peak by 
the sum of all trace peak areas within the Global filter retention time range, set with Show peaks within 
range:. In the example above, any trace peak with a Normed area % less than 5% is filtered out. Flag if 
peak ratio above or below: sets a peak ratio (relative ro the reference sample) threshold flag and is only 
applicable for comparison mode projects. 

The Traces table and trace peak settings are backwards-compatible. Traces associated with samples in 

projects from software versions before 3.8 will correctly populate the Traces table in the current version. 

Trace peak settings and presets from versions before 3.8 will correctly migrate into the current version. 

However, Intact Analysis and Chromatogram Analysis projects created in versions 3.8 and above will not 

correctly open in older versions of these applications. 
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Sequences and masses Tab 

Sequences Sub-tab 

 

Figure 17: Sequences sub-tab. 

The user can add amino acid sequences or masses to the Chains table, and based on these chains add 
rows to the Sequence combinations table. Each row in the sequence combinations table can represent a 
single chain or combinations of chains. For example, for analysis of intact IgG1 mAb two rows are added 
to the Chains table, for the light and heavy chains, and one row is added to the Sequence combinations for 
2xLight chains and 2xHeavy chains (set in the Composition column). For reduced analysis of an IgG1 
mAb, two rows are added to the Chains table, for the light and heavy chains, and two rows are added to 
the Sequence combinations table, one row for 1xLight Chain and a second row for 1xHeavy chain  The 
user enters a protein sequence either by dragging and dropping a FASTA file, manually typing it in, or 
selecting from a FASTA file.  

Users can designate peptide chain masses without sequences as average mass or monoisotopic mass. In 
the Chains section, a radio button selects between the two types of masses and the mass header updates 
accordingly: 

 

Figure 18: Average or monotopic mass assignment 

The software automatically computes the average and monoisotopic mass for each entry in the Sequence 
combinations table, and these masses are then available for automatic peak assignment. The default 
computation assumes that Cys residues are disulfide bonded, but this default can be changed by the user. 
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Average or monoisotopic masses give the software reference masses to assign mass peaks automatically 
based on the Delta Masses table (discussed later).  

The Mirror Chains table check box populates the content from the Chains table into the Proteins table. 
This is shown below:  

 

Figure 19: Mirror Chains table option 

For each row in the “Chains” table, a corresponding row is added to the Sequence combinations table (with 
single-chain composition and all possible disulfides). The user can also set the number of disulfides within 
the Proteins/protein complexes table. The “Disulfides” window is activated by double clicking within the box 
within the table, as shown below: 

 

Figure 20: Disulfides. 

To set a specific number, select “Disulfides count” and enter a value, as shown below: 

 

Figure 21: Disulfides count. 

Sequence combinations are associated with all samples, by default. However, they can be associated with 

an individual sample. Click  after the Sample Id for the desired sequence combination to open the Edit 
samples selection dialog: 

 

Figure 22: Edit sample selection for sequence combinations 

Check either All samples or one of the sample rows and click OK. More than one checked sample for a 
sequence combination is not supported. 
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The user can also direct the software to consider clipping. As shown in figure below, select the box to 
activate – there are the options: 1. “Clip at specific sites” or 2. “Clip everywhere”. Click Add to enter specific 
residues depending on the radio button selected. 

 

Figure 23: Consider clipped species, Biopolymer model and Mass computation options 

Users can select the kind of biopolymer model used to convert average mass to monoisotopic mass and 
monoisotopic mass to average mass: 

 

Figure 24: Biopolymer model choices 

Biopolymer model options include: 

Infer from sequence or biopolymer type is the default selection, which uses the standard model 
that Intact Analysis has used to calculate mass. 

Protein (C0.3171 H0.4981 N0.0872 O0.0949 S0.0027) uses the displayed averagine formula to 
calculate mass. 

Custom opens a cell to the right of the selection to add a custom formula to calculate mass. 

Note that the formula values refer to atom counts (molar ratios), not mass ratios.  

There are also a few Mass computation options shown in figure below. The user should select which to 
consider when calculating the masses.  

Within the Sequences and masses tab, there is also the Building blocks tab, as shown below: 
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Figure 25: Building blocks sub-tab. 

There are several parameters to consider in this tab. As shown in the three figures below, the cysteine 
modification can be clarified by selecting amongst the 3 options. The chemical formula will be adjusted 
accordingly.  

 

Figure 26: Unmodified cysteine (default). 

 

Figure 27: Carbamiodomethylated cysteine. 

 

Figure 28: Carboxymethylated cysteine. 

 

The user can also specify the average mass of each chemical element, as shown below: 
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Figure 29: Chemical Elements 

Delta masses 

The Delta masses in the center of the Sequences and masses tab (shown in Figure 50) gives a table of 
likely mass differences between observed peaks and the reference mass (either input by the user or 
computed from an amino acid sequence, as completed in the Proteins section). Byos uses this information 
to assign peaks based on mass differences from Reference peaks. Check each group to include it for peak 
assignments. The mass names and Dalton values can be edited by selecting and typing new values. The 
user can also add delta masses not available by default by clicking Add row and entering a mass name 
and mass manually. This is shown below in 5.  

 

Figure 30: Add row to add a delta mass. 

Any row can be deleted by highlighting and clicking the Remove rows button. Select multiple rows by using 
Ctrl-click or Shift-click. This is shown below in 6.  
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Figure 31: Remove rows. 

The user can also import a custom list (.CSV) by clicking Import and selecting a saved delta mass table in 
CSV format. This is shown below: 

 

Figure 32: Import a custom mass deltas list. 
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Intact options 

 

Figure 33: Intact options. 

The Intact options section on the right side of the Deltamasses tab (shown in Figure 50) includes Basic and 
Advanced entries for Mass range, m/z range, mass peak picking, and peak sharpening parameters that are 
applied to all trace peaks. 

The Basic tab contains the primary settings used in computing deconvolved masses. Mass range and m/z 
range set ranges for neutral masses and m/z, respectively. Mass range defines the range of neutral masses 
displayed in the Deconvolved mass spectrum. M/z range defines the segment of the MS1 spectrum used 
to compute neutral masses. 

Within the Auto mass peak picking parameters, Min difference between mass peaks and Max number of 
mass peaks control peak picking. Min difference between mass peaks prevents the peak picker from picking 
multiple points on top of a ragged or isotope-resolved mass peak. Max number of mass peaks sets a limit 
on the number of picked peaks. 

The Peak sharpening dropdown controls an optional “super-resolution step” that sharpens peaks beyond 
what is seen in the data. It deconvolves a “point spread function” to give super-resolved mass peaks and 
turn shoulders into separate peaks. The Spread function width sets the expected width of a peak when 
peak sharpening is enabled. A reasonable width is the square root of the peak mass in kilodaltons, for 
example, 12 for a spectrum from 140,000 to 150,000 Da. A too-narrow width will not sharpen much, and a 
too-wide width might split peaks. Peak sharpening on mass spectra that span a range of more than about 
20,000 Da is not recommended, because no single width will be optimal for the entire range. Peak 
sharpening should also be avoided on isotope-resolved mass spectra. 

The Advanced options mainly concern resolution. The user will only need to use this tab if the aim is to 
produce isotopically resolved neutral mass spectra. 
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Figure 34: Advanced options. 

Charge vectors give the charge assignment probabilities for each small interval of m/z points. 
Deconvolutions of most MS1 spectra will be almost exactly the same with any Charge vectors spacing 
from 0.2 to 1 m/z units (Thomsons), but a narrow spacing of 0.1 may give better results on isotope-resolved 
MS1 spectra with interleaved signals, and a wide spacing of 2 may give better results for native MS with 
broad m/z peaks.  

Intact Analysis removes an m/z baseline before deconvolution; this step and removal of charge one or stop-
list peaks are the only steps in the algorithm that do not conserve ions. Baseline radius controls the 
stiffness of the baseline. A baseline radius of 8 gives a flexible baseline that will cut into m/z peaks broader 
than 8 Thomsons; this will often give better visual separation of neutral mass peaks, but may distort peak 
areas. A baseline radius of 30 will give a stiffer baseline that cannot cut into m/z peaks narrower than 30 
Thomsons. An even larger value, 100 or more, may be needed for native MS. The default value of 15 is a 
compromise.  

Spacing (m/z) controls the spacing of sample points in the m/z spectrum. The raw MS1 data is represented 
as a continuous piecewise-linear function that can support any spacing of sample points, but m/z spacing 
finer than the finest spacing in the original data will slow the computation without adding resolution. 
Reasonable values for Spacing (m/z) are in the range 0.005 – 0.05 for QTOF instruments, which have 
almost the same resolution at all m/z; the low setting of 0.005 would be appropriate for Bruker maXis and 
the higher setting of 0.05 for older instruments with lower resolution. For Orbitrap, the resolution depends 
upon m/z; the setting of 0.005 shown above is for isotope-resolved 25 kDa masses (antibody subunits). For 
native MS on Exactive EMR with m/z’s in the 5000 – 10,000 range, a spacing of 0.1 is fine enough. 

Smoothing sigma is typically set to the same value as Spacing (m/z), but a larger value can be helpful for 
producing an appropriately smoothed neutral mass spectrum with less smoothing at lower mass and more 
smoothing at higher mass.  

Mass spacing controls the spacing of points in the neutral mass spectrum. To preserve isotopic resolution, 
spacing should be set to 0.1 or even 0.05. If the MS1 spectrum does not have isotopic resolution, or isotopic 
resolution is not needed for analysis, mass spacing in the range 0.2 to 1 is best for target molecules below 
200 kDa. Spacing of 10 Da or more is best for targets above 300 kDa. For mass spectra without isotopic 
resolution, Mass smoothing sigma in the range of 2 – 5 will smooth jittery peaks in the range 20 – 200 
kDa; larger values will be needed for larger masses. For mass spectra with isotopic resolution 0.1 will work.  
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Iteration max set to 10 will work for most purposes. A larger value, for example 20 or 30, can be helpful 
for lower signal-to-noise spectra that take longer to converge.  

Charge range is best set to a wide range, in which case the charge range will be implied by the mass and 
m/z ranges. The default range of 5 – 100 covers most applications, but 5 will need to be reduced for 
deconvolutions with mass range starting below 10 kDa, and 100 increased for targets that may have 
charges above 100.  

Sharpening uses the Spread function width set in the Basic tab to deconvolve the data. Blur skewness 
controls the asymmetry of the point spread function; the default value of 1.1 means that the right tail has 
sigma (standard deviation) 10% bigger than the left tail. 1.2 gives even more tailing; 1.0 gives a symmetric 
point spread function. Range sets the length of the tails in standard deviations; a small value of 5 or 6 may 
work better in the case of Lorentzian point spread. Blur type has two choices: Gaussian (skinny tails) and 
Lorentzian (fat tails). Lorentzian should use a slightly smaller sigma than Gaussian. 

Sample-protein input Tab 

The Sample-protein input tab allows for association of protein sequences with the samples that contain 
them: 

 

Figure 35: Sample-protein input tab 

Sample-protein associations can be imported from *.csv files and from MS files. To create csv files from 
other projects, use File > Export > Generate MS path template CSV. This capability is useful for making 
a single Intact Analysis project with many different samples. Imports to the tab support custom fields. 

Processing nodes 

 

Figure 36: Intact Processing nodes tab. 

• General 
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Figure 37: General parameters. 

o Samples - The “*” character applies all parameters to all samples dragged and dropped 

into the Samples tab. 
o Enable Lock-Mass Calibration can be set as yes or no. 
o Lock Mass (m/z) sets the calibrant m/z value. Several are available using the drop-down 

menu or the user can type in a numerical value. If empty, no calibration will be applied.The 
user can select: 

 

Figure 38: Lock mass drop-down values. 

• Mass assignments 
 

 

Figure 39: Mass assignments. 

The Mass assignments parameter allows the user to turn on/off charge deconvolution and automatic mass 
assignment. The default selection is Auto charge deconvolution and mass assignments. For new projects, 
especially those with longer chromatography times, significant computation time may be saved by creating 
the project with the setting No charge deconvolution selected. The summed m/z spectra can then be viewed 
before deciding which elution peaks warrant deconvolution. Similarly, charge deconvolution without mass 
assignments will let the neutral mass spectra be viewed before mass peak assignment. 

• Mass Area and Relative Intensity Options 

 

Figure 40: Mass Area and Relative Intensity Options 

o Compute Areas of Mass Peaks 
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o Mass Area Width compute peak area within a band around each mass, defined by the 
mass area width value 

o Report Intensities Relative to Local Base Peak controls Expected Type flagging of mass 
peaks based upon the two below parameters. Expected Type flagging is useful for reporting. 

o Window for Local Base Peak (%) sets a mass range window for local base peak(s) (e.g. 
mass within +/- 20% of Local Base Peak mass),  

o Minimum % of Local Base Peak  flags masses below the set % intensity of local base 
peak as Expected Type=Ignored. All masses with a % local base peak above this minimum 
will have an Expected Type of Desired (if mass is assigned to a Desired Sequence 
Combination), Undesired (if mass is assigned to an Undesired Sequence Combination), or 
blank (if mass does not match to any Sequence Combination). Users define Sequence 
Combinations as Desired or Undesired in the Sequences and Masses workflow tab. 

o Generate zoomed-in segments The user has 3 options: None, using reference masses, 
Using observed masses (per highest local base peak).   

o Plot segment width Segments can be set to be automatically generated around 
reference/observed masses for deconvoluted mass spectrum and MS1 plots during project 
creation. 

 

• Advanced 

 

Figure 41: Advanced. 

Several advanced commands can be applied to Intact Analysis processing by adding in the 
Advanced configuration text box. Please refer to the Advanced Commands section of the 
Intact Analysis Manual. The user can select between Positive and Negative using the drop-
down menu. 

• Report 

 

Figure 42: Report Configuration Path 

Each Byos default workflow includes a report template created by our Customer Success team 
that is optimized for the specific type of analysis. If the user prefers a customized report template, 
they can direct Byos to this file using the light blue “…” button. They will be prompted to select a 
.rptc file. 

• UI Configurations 

 

Figure 43: UI Configurations – UI Column Filters and UI Layout.  

The user has the ability to import column filters as well as layout files. This is designed to standardize 
analyses across all users, labs, and sites. The user can direct Byos to the preferred file for each using 
the light blue “…” button. The user will be prompted to select a .cft (Filters) or .ini (Layout) file.  
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• Time Settings 

 

Figure 44: Time Settings 

o Alignment max time sets the maximum alignment value between plots (for example, UV and 
TIC). This value will limit the allowed alignment time between the two signals. The default 
value is set to 1.00.  

 

• Label Scripts 

This feature allows users to customize peak labels for Trace plot and Deconvolved Mass Plot. 

 

Figure 45: Label Scripts 

Scripts related to trace plot are in C:\Program Files\ProteinMetrics\PMI-

Suite\Base\labelscripts\traceplot folder, while the scripts related to deconvolved 

mass plot are in C:\Program Files\ProteinMetrics\PMI-

Suite\Base\labelscripts\dmsplot folder. To load a script during project creation, select 

Processing nodes, expand Label Scripts, click on … for Trace plot (or Deconvolved mass plot), 
then click Load to select a script, then click OK and Create Project. This will result in creation of 
the project with custom labels as specified in the script.  

The user has an option to load scripts after project creation as well. To customize peak labels 
after project creation, select Rendering options icon, click Edit Annotations, then click Load to 
select a script, then click Open and click OK to display new custom labels.  

• Peak Construction options (older versions of Byos) 

The Peak Construction option parameters formerly found in Byos are now set directly in the Samples 
tab with the buttons Edit trace peak options and Edit global trace peak filters. 

Peak Annotation and Quantification 

After project creation, a typical workflow filters trace peaks, computes further deconvolutions, and annotates 
neutral mass peaks. These operations are highly automatable for most samples (such as purified mAbs) 
without sacrificing manual inspection and validation. 

To select a trace peak, either click the peak row in the Trace Peaks table (Figure 58), or Alt-click the peak 
in the Trace plot view (Figure 56). The pink vertical lines represent the trace integration start and end times. 

To change the time limits of the peak, hover over a pink line until the arrow  icon appears, then click and 
drag to the desired integration limit. 
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Figure 56: Modifying peak integrations 

The MS1 plot recomputes the summed m/z spectrum automatically. Click the orange Compute button 
above the deconvolved mass spectrum and apply desired parameters to produce a new neutral mass 
spectrum. A variety of time windows can be used to obtain the clearest set of deconvolved mass spectra. 
A single trace peak can be split into finer time slices to distinguish early versus late elutes in a 
chromatographic profile. Trace peaks can overlap arbitrarily; trace peaks 2 and 3 above share the same 
apex, but peak 3 covers 36 to 48 min, that is, all three of the peaks we see by eye. The Labels button lets 
the user change the way trace peaks are labeled. 

After deconvolution, Intact Analysis chooses a number of peaks (the default is 10) in the deconvolved 
spectrum and labels them with their masses. Peak picking is controlled by two parameters in the Compute 
menu: the minimum difference between peaks and the maximum number of picked peaks. Other controls 
are available through Advanced commands; see the Appendix. Picked peaks can be assigned either 
automatically or manually to make them persistent and available for reporting. Mass assignments remain 
when the maximum number of picked peaks is reduced, but are discarded when the deconvolution is 
recomputed, because the mass peaks may change. 

The picked peaks can be labeled through the Masses table. When the software assigns masses, 
“Reference” labels are automatically derived from the input protein sequences (Sequence Combinations 

table), and labels such as “G0F/G0F” derived from the enabled mass deltas (differences from reference 

mass). Names and other fields can be edited manually. In the Masses table, click the Name field in a mass 
that is checked as assigned, click the name, and then either click the drop-down arrow and select a value 
or enter free text. 

 

Figure 57: Editing assigned masses in the Masses table 

Assigned masses in the Masses table appear as sub-rows in the Trace Peaks table. The trace peak header 
row inherits values from the mass sub-rows. 
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Figure 58: Mass values in the Trace Peaks table is inherited from assigned masses in the Masses table 

By default, candidate annotations display values from Protein name and Delta name in the Deconvolved 
Mass spectrum. To display mass names in this view, do the following: 

1. In the Deconvolved Mass spectrum view, click the gear  icon. 

2. Click Edit annotations. Click the Short Codes  icon. 

3. Select the [Sequence] short code and click Insert. 

4. In the Template Editor, click OK. In the Render and zoom options dialog, click OK. This setting 
will be saved with the project. 

5. The assigned mass name for a peak will now be displayed above its neutral mass in the 
Deconvolved Mass spectrum view. Horizontal grid lines can be turned on/off, and font sizes can 
be adjusted by right-clicking on the plot. 

 

Figure 59: Displaying mass names in the Deconvolved Mass spectrum 

Main Menu Bar 

The topmost menu bar includes four items: File, Edit, Window, and Help. 

File Menu 

The File pull-down menus manage project files and export reports and data. The File menu includes itemsto 
open previously created projects, to save a copy of an open project, to close a project, and to exit the 
program. There are also three menu items to export reports and data.  
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Figure 62: File menu with Export sub-menu 

File > Export > Report generates a report that includes a summary of the project files, one or more pivot 
tables (that can be visualized as heatmaps, bar charts, etc.), along with plot images. 

 

Figure 63: Default project report generated from File > Export > Report. 

In the Figure above, the heatmap view of a pivot table gives the intensity information from Figure 58. 

To replace the report with another report template, choose in the report window File > Presets > Report 
presets > <template name>: 
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Figure 64: Changing the report template in a created report 

The template intact_icIEF_Report.rptc supports electropherograms from *.itb trace files; all the others 

support chromatograms. Choose File > Save to document to persist the new report to the project. 

The File > Export sub-menu includes the item Generate Multi-document Report. A multi-document report 
creates report tabs derived from the table and graphical data from a series of reports. 

 

Figure 65: Multi-document report 

To learn about reports in detail see the document PMI Reporting Manual.pdf. 

Edit Menu 

The Edit pull-down menu manages program settings. 

 

Figure 66: Edit menu 
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Undo and Redo allow the user to undo or redo changes. These Edit menu functions are also available as 

toolbar buttons below the menu bar . 

Recompute trace peaks and baseline opens the Trace peak options dialog that includes settings to 
modify and recompute the trace peaks.  

 

Figure 67: Trace peak options using Edit > Recompute trace peaks and baseline 

This is equivalent to the dialog opened by the Edit trace peak options button in the Sample Input tab 
when creating a new project. Thus, the user has the option to alter the trace processing before and/or after 
project creation. For details, see the Trace peak options section. 

Compute Options opens the Trace peaks compute options dialog, which includes a list of trace peaks, 
the samples that contain these peaks, and the peak start and end points. To change the deconvolution 
parameters (m/z range, m range, etc.) for a trace peak(s), click Edit selected peaks… to edit all selected 
peaks. This opens the Intact options dialog: 
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Figure 68: Compute options 

See the Deconvolved Mass Spectrum Menu section for more information about the basic and advanced 
Compute options. 

After the settings are modified, click Save and Compute. The program computes an MS1 summed m/z 
spectrum, a deconvolved (neutral) mass spectrum, and assigns a peak list in the Masses table for each 
trace peak check on in the Selected column. 

The Name column in the Masses table is also updated when newly added delta masses or proteins have 
been matched after recomputing. The new value in the Name column is most often created using the values 
in the Protein name and Delta name columns. The report is updated automatically with the new Name 
values.  

Unassign all masses removes all mass peak assignments over all trace peaks. 

Auto compute and assign masses computes and optionally assigns convolved masses using the last 
used set of compute mass settings. Check Auto assign masses to have the application assign 
deconvolved masses. Click Selected Peaks to assign masses to selected trace peaks. Click All identified 
Peaks to assign masses to all trace peaks. 

 

Figure 69: Compute and assign masses 
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The Delta masses table assigns peaks based on mass differences from Reference masses (defined in the 
Sequence Combinations table). Check each group to include for peak assignments. The mass names and 
Dalton values can be edited by selecting them and typing new values. To add an additional delta mass 
record, click Add row and enter a new mass name and Dalton value to the new record at the bottom of the 
table. Import opens a saved delta mass table in CSV format. The mass peak Match tolerance can be 
adjusted, although average and monoisotopic mass matching option can only be set prior to project 
creation. Add combinations automatically creates mass shift values for combinations of modifications..  

 

Figure 70: Delta masses 

The Sample table is used to customize the Project view. To add a comment for a sample, click in the 
Comment cell and enter text. To add a new column, click Add custom column, enter the column name 
and an optional default value and click OK twice. The column will appear after Comment in the Project view. 
To remove a custom column, click Remove custom column, select the column and click OK. 

The Protein table is used to add proteins associated with a sample. Proteins are described by name 
(Accession name), sequence, and average mass. They are assigned to samples by the Sample ID. A 
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protein defined in this table will automatically be labeled as Reference during automated mass 
assignments. As above, custom columns can be added and removed. 

The Sample-proteins table combines the Sample and Protein tables so that they can be edited 
simultaneously. The Sample-proteins table is especially convenient for monoclonal antibodies (mAbs). 
Each row corresponds to one sample (MS spectrum file) with a mAb containing one light and one heavy 
chains. As with the Protein table, custom columns can be added and removed. 

 

 

Figure 71: Sample-proteins viewer 

Reconstruction table allows the user to reconstruct intact mass spectra of proteins from peptide 
mapping data Protein degradations at the amino acid level quantified by peptide mapping methods are 
convolved against each other to reconstruct a theoretical intact mass spectrum. Comparing the 
theoretically reconstructed intact mass spectrum against the experimental spectrum provides a way to 
compare peptide mapping data against intact mass spectrometric analysis. The differences between the 
two spectra can then be used to compare how well each method correlates with the other. This can then 
be used to adjust acquisition or data analysis settings accordingly. For detailed information, see the Intact 
Reconstruction section of this manual. 

Generate mass plot segments controls how neutral mass spectra will be plotted in reports. A small 
Segment width will give many plots; a larger width will give fewer plots but less detail. 

 

Figure 72: Generate mass plot segments 

Plot segments of the size specified will automatically be generated around either referenced or observed 
masses. 

Attach report configuration attaches a report configuration file to the project, to be used instead of the 
default report configuration. Report configuration files (graphical layouts) are generated from File > Export 
> Report and have the extensions *.rptc. This menu can also be used to remove an attached report 

configuration file. 
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Figure 73: Intensity options 

Mass area and relative intensity options can toggle Mass area calculation on and off and set a default 
Mass area width in daltons across which a peak is integrated to determine its area. Window for local base 
peak sets local base peak mass range as a percentage of the base peak mass that defines a local peak 
group. Minimum % of local base peak sets the minimum intensity below which masses have Expected 
Type=Ignored. All masses with a % local base peak above this minimum will have an Expected Type of 
Desired (if mass is assigned to a Desired Sequence Combination), Undesired (if mass is assigned to an 
Undesired Sequence Combination), or blank (if mass does not match to any Sequence Combination). Users 
define Sequence Combinations as Desired or Undesired in the Sequences and Masses workflow tab. 

Show project creation options is obsolete and can be ignored.  

Show Byos project creation options displays the Byos workflow project creation options used to generate 
the project. Users can edit the workflow settings, but these workflow edits are not applied to the current 
project.There is also no option to create projects from this view. Users can use this tool for three purposes: 

1. View the project creation options used to create the current project. 
2. Click Save As Portable Workflow… to create a folder containing the .wflw and associated files 

(like .rptc). 

3. Edit the project creation workflow settings and then click Save workflow… to create a new 
workflow, using the current project creation settings as a starting point. The new workflow must be 
opened using File>Launch Workflow… to create a new project.   
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Figure 74: Show Byos project creation options 

The Advanced configuration dialog is used to enter text commands, which are often new features still in 
beta testing. A list of available advanced commands can be found here.  

Adjust colors is used to modify the default colors associated with samples and traces. 

Adjust MS paths is used to modify the path to the source MS file, should the file be moved. Enter or 
navigate to the new directory containing the MS file. 

 

Figure 75: Editing the MS file path 
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Edit PDB loads protein database files for use by Protein 3D reports. 

 

Figure 76: Edit PDB files 

Window Menu 

 

Figure 77: Windows menu 

The Window pull-down menu manages layouts, as well as the arrangement and sizes of the various table 
and plot views. Load Layout opens a saved layout stored to files with extension .ini. Save Layout saves 

the current layout to an .ini file. Restore Default Layout applies the layout used when the application is 

first opened. The current layout is customized by hovering over the vertical or horizontal edges between 

table and plot views so that the cursor changes to arrows:  or . Left-click and drag the edges up, down, 
right, or left to change the sizes of the views. Columns in the table views can be made larger or smaller in 
same manner. To reorder columns in a table, left-click the name of the column and drag it to the new 
location. To do a simple sort, left-click the header once to sort ascending and twice to sort descending. 
Mouse over a column header to see a description of that field. Enable Mass XIC, when selected, allows 
the user to assess the elution profile of deconvolved species This feature is discussed more in detail in the 
Mass XIC section.   

Column headers can be modified through the Column Header Editor dialog, opened by a right-click 
anywhere on a table column header. 
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Figure 78: Column Header Editor 

Columns can be rearranged by dragging the header names up or down. To hide a column, uncheck the 
Visible box for that column. This dialog can also be used to specify number of significant figures and ranked 
sorting. The Window > Save Layout menu preserves these edits for future use and sharing. The Reset 
row sorting and Reset column order buttons restores the default row and column properties. The Search 
Box can be used to search for specific values or variables, with options to filter for only whole values, with 
case-sensitivity, and to only search in vertical header columns. 

 

Figure 79: Search Box filters 

A selected row can be moved to the top or the bottom by clicking Move to bottom or Move to top; 
alternatively, the same actions can be performed by pressing Alt + t or Alt + b, respectively.  
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Help Menu 

 

 

Figure 80: Help menu 

The Help pull-down menu provides information about the software. The About menu shows the software 
version number, which is needed when reporting issues. The Log menu opens a log containing recent 
activity; this is helpful for troubleshooting problems together with Protein Metrics staff via 
support@proteinmetrics.com. Support Package collects all relevant information helpful for troubleshooting 
problems together with Protein Metrics staff via support@proteinmetrics.com. Open User Guides opens 
the document directory where this and other useful guides can be found, including PMI Intact Analysis 
Manual.pdf. Check For Updates checks whether software updates are available on 
www.proteinmetrics.com. Online Resources opens the www.proteinmetrics.com/secure-resources site 
which offers specialized workflows and additional information about Protein Metric products. Register is 
used to activate the software upon first use. 

Tables and Menus 

The menu bars at the top of the three table views, Project, Trace Peaks, and Masses, share icons that 
manage hierarchical lists and filter data. 

● The  icon expands rows to show “sub-rows”. 

● The  icon collapses rows to hide sub-rows. The use of sub-row depends on the table. For 
example, in the Trace Peaks table a row is a trace peak and a sub-row is a mass peak within 
the deconvolved spectrum. 

● The  icon exports the table to a .csv file for opening with Excel. 

● The  icon opens a dialog to create custom filters for the data table. Select a column in the first 
cell, select an operator in the second cell, and enter text in the third cell. A second filter row 
becomes available for further entry. Click the red X after a filter row to delete it. Custom filters 
allow masses to be filtered by mass range, annotation, intensity, and so forth. Custom filters can 
be stored with the project document or exported and imported using the Presets dropdown. 

mailto:support@proteinmetrics.com
mailto:support@proteinmetrics.com
https://www.proteinmetrics.com/
https://www.proteinmetrics.com/secure-resources/
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Figure 81: Column Filters Editor 

● The  cell filters the entered text across the content of all columns in the protein 
and peptide tables. The records are filtered automatically as text is entered. Click the  icon to 
search the string as a whole word or as case sensitive. 

● To sort the contents of a column by ascending value, click the column header. Click the column 
header again to sort by descending value. 

Table Right-Click Menus 

The Project, Trace Peaks, and Masses tables have context menu items revealed by a right-click on the 
rows within the tables. (Recall that a right-click on the header of these tables opens the Column 
Header Editor dialog.) 

 

Figure 82: Table right-click menus 

● Export table to CSV saves the table content and headers to a .csv file using parameters 
chosen in the Export data dialog. 

● Copy selected row(s) to clipboard copies selected table rows, with their headers to be 
available for pasting into another application. (This menu is not available in the Protein 
Coverage table.) 

● Copy selected cell to clipboard allows the user to copy the contents of the selected cell. It 
works just like CTRL+C. 

● Table context menus contain a set of query options for searching the clicked text value using 
any of the available search operators. This is an easy way to filter a table based on a specific 
field value. 
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Figure 83: Right-click field searches 

A table view’s menu bar may also include buttons and icons specialized for that table. 

Project Table and Menu 

The Project table contains information about the MS samples: 

 

Figure 84: Project Table 

Check or uncheck Show trace or Show peaks to show or hide these features for particular samples. To 
edit an MS sample, right-click the entry to edit under the Sample Name header, click Edit selected row(s), 
edit the name, and then click OK. 

Trace Peaks Table Menu 

The Trace Peaks table contains details about identified peaks, organized by sample: 

 

Figure 85: Trace Peaks table 

To view specific peak data for a sample, click the > symbol to the right of that sample: 
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Figure 86: Trace Peaks sub-table 

The Trace Peaks table includes the following specialized buttons: 

● Add Peaks opens a dialog for the input of start and end times for a new peak. 

● Delete Peaks deletes the selected peak. 

● Merge Peaks merges a contiguous set of selected peaks into a single peak. Use left-click and 
shift-click to select a set. 

● Split Peak splits a peak into two peaks. The time values for the two peaks can then be adjusted 
separately. 

● Filter options: The magnifying glass  opens a dialog that allows the user to adjust the trace 
peak filter by overall trace time or minimum peak area (percent of TIC) to determine which trace 
peaks will be processed. 

The Trace Peaks table includes the specialized right-click menu Edit selected row(s). This menu is 
available from certain numeric fields such as Start time, End time and Apex time, and for annotation fields, 
such as Mass Comment, Peak Comment and Visible. This allows the user to overwrite the computed values 
for those fields for the given sample, as well as mark or comment on samples peak records. 

Masses Table Menu 

The Masses table reports the masses of the most intense peaks that are selected in the Trace Peaks table. 

 

Figure 87: Masses table 

The Masses table includes the following specialized buttons: 

● Assign Masses assigns selected rows, an alternative to checking the Assigned boxes. If there 
is no selected row, Assign Masses opens a dialog to define a new mass by name, neutral 
mass, start and end times, intensity, and comment. 

● Unassign Masses can be used to unassign selected rows. 

The Masses table includes the specialized right-click menu Edit selected row(s). This menu is available 
from certain numeric fields, such as Mass Start, Mass End, and Mass Area, along with other fields, such 
as Mass Comment and Name. This feature allows the user to overwrite the computed values for those 
fields for the given sample, as well as mark or comment on mass records. 
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Plots and Menus 

The menu bars at the top of the three plot views, Trace plot, MS1, and Deconvolved mass spectrum, share 
icons that that support generic operations on plots. These icons appear in almost all of Protein Metrics’ 
software products. 

● The  icon resets the plot to default zoom level. Shortcut = double left-click. 

● The  icon enables zooming in. After clicking, the cursor changes to . Drag across the 
range of the plot to display to zoom to that x-range. 

● By default, the plot’s y-range scales according to the maximum y-value within the x-range, but 

the software also supports freeform zooming as described under the  icon. 

● The  icon enables zooming out. Click anywhere in the plot to zoom out. 

● The  icon enables moving (panning) across the plot. The cursor changes to this icon. Click 
the plot and drag up or down, right or left to view a part of the plot that is off-screen. 

● The  icon performs an undo of the last zoom step. Shortcut = Shift-left arrow key. 

● The  icon performs a redo of the last zoom step. Shortcut = Shift-right arrow key. 

● The  button scales the y-coordinates so that the tallest peak has intensity 1. 

● The  icon manages plot segments and zoom states. The number displayed in the icon shows 
how many plot segments are stored (named by the date and time of the save). To save the 

current zoom state as a plot segment, simply click the  icon. To switch to a previously stored 
plot segment, click the drop-down arrow and select the segment. To add, remove, rename or 
edit plot segments, click the drop-down arrow and then click Edit. To display all the plot 
segments at once, as seen on the right, check Show segments in the Plot segments dialog. 

 

Figure 88: Defining plot segments 
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Figure 89: Spectra resulting from defined plot segments 

● The  icon manages how plots are displayed (render options), as well as zoom modes.  

 

Figure 90: Render and zoom options 

o Show candidate match details (MS1 only) applies to Chromatogram Analysis only. 

o Show peptide labels (MS1 only) displays peptide labels in red below the identifying 
labels for the corresponding peaks. 
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o Show x values and Show y values display the x- or y-coordinates beside plot peaks to 
the chosen number of significant figures. Show delta displays the x or y differences from 
a reference peak. To display the deltas, hover the cursor over the reference peak (which 
displays as 0). The other peaks show the positive or negative differences for that axis. 

o Show centroided peaks darkens the peak positions that are determined to be 
centroided. 

o Show plot title displays the title of the plot, for example, “M[10000-30000] m/z [600-
3000]” seen above. The information shown in the plot title can be customized by clicking 
the Edit plot title button. This opens the Template Editor dialog. The editor accepts free 
text or programmatic “short codes” that insert data values into the title. For example, 
“Time range [[StartTime] - [EndTime]]” displays the starting and ending times derived 
from the trace as part of the title for any of the plots. 

o Show annotations (Trace plot and Deconvolved mass spectrum) displays text values 
beside peaks, which can be customized with the Edit annotations button. This opens 
the Template Editor dialog, which displays the default annotations: 

 

Figure 91: Template Editor for Edit annotations 

The editor accepts free text or programmatic “short code” that use data values in the peak 
annotations. For example, [ExpectedMass] displays expected mass labels for 

individual peaks in the Deconvolved mass spectrum. 

o Label orientation sets the angle for the label text, where 0º is vertical. 

o Show m/z baseline (MS1 only) overlays a smooth m/z baseline. 

o Show selected plots only (Trace plot only) shows only the selected trace trace(s). 

o Mass to m/z dot render options (MS1 only) control the display of the colored dots 
linking neutral mass peaks to the MS1 spectrum. Show charge labels, which is on by 
default, displays the charge assignments next to the colored dots. Limit visible circles 
by count places a limit on the number of dots of each color, and Limit visible circles by 
maximum intensity places a minimum intensity threshold, a percentage of the maximum 
y-value for that color. Dots are placed at computed m/z values for a selected neutral 
mass peak, regardless of whether the m/z value is a peak (local maximum); m/z values 
are adjusted slightly to avoid falling into a gap between isotope-resolved peaks. There is 
no limit on the number of selected mass peaks, but there is a limit of 10 dot colors.  
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Figure 92: Mass to m/z dot renderings 

o Scale by charge probability (MS1 only) changes the colored dots to stars for m/z points 
corresponding to selected masses.  The x-coordinates of the stars are the same as the x-
coordinates of the dots, but the y-coordinates show the fraction of the m/z intensity 
assigned to the selected mass. Full height (same y-coordinate as the dot) means all of 
the intensity is assigned to the selected mass; baseline height means none of the 
intensity is assigned to the mass. This feature is especially useful in the case of different 
masses sharing the same m/z peak; for example, monomers and dimers with overlapping 
m/z ranges. 

 

Figure 93: MS1 plot with no charge probability scaling 
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Figure 94: MS1 plot with charge probability scaling applied 

Zoom and pan mode options include: 

o Free form mode to select the desired y range as well as x range 

o Auto scale mode to select only the x range (the y range is then determined by the value 
of the highest peak) 

o Locked view mode to keep the current x range (for either m/z and/or m) when moving 
between trace peaks 

o Locked x-axis mode which turns off autoscaling for the x-axis (but not the y-axis) and 
applies the current x-axis scale across all Peptide table selections. 

Under Scrolling, the Visibility setting controls display of the scroll bars: 

o Always on displays scroll bars even when the full plot is shown 

o Always off turns off display of the scroll bars even when a partial plot is shown 

o Show as needed displays scroll bars only when a partial plot is shown 

● The Offset entry on a plot menu bar controls the vertical spacing for stacked plots. Offset of 
100% means that plots stack top-to-bottom without any overlap. Offset of 70%, as seen to the 
right, means that plots overlap by 30%, and offset greater than 100% leaves white space 
between stacked plots. 
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Figure 95: Trace offsets 

● Reconstruction mass is used to reconstruct Intact mass spectra of proteins from peptide 
mapping data. Refer to the Intact Reconstruction section for detailed instructions for how to run 
this analysis. 

Plot Right-Click Menus 

The Trace plot, MS1, and Deconvolved mass spectrum have a variety of context menus for plot styling and 
exporting revealed by a right-click on the plots: 

 

Figure 96: Plot right-click menu 

Figures exported can be useful for reports, publications, regulatory filings, or internal communications. 
There are many options for rendering and exporting so that the user has much freedom to prepare a plot 
or figure style as needed. 

● Adjust X-Y axis limits opens a dialog for the user to manually edit the plots x and y maxima 

and minima. This is a less convenient but more precise (and reproducible) alternative to the  

and  icons. 

● Export image allows the user to save the plot as a *.pdf report or as a *.png, *.wmf or 

*.svg image file. It opens the Plot Exporting Settings dialog, which controls image size, file 

name and folder, and x and y minima and maxima. Sometimes a user wishes to display a wide 
range across the x-axis and yet retain significant detail. This can be done by breaking up the 
plot into a series of panels. The Add segment button creates segments with user-defined x and 
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y values. A series of these segments eliminates unneeded portions of the plot and increases the 
effective detail in the image. This is also a useful function for automated reporting. The Re-
segment button allows edits to the reported x and y minima and maxima for existing segments: 

 

Figure 97: Plot Exporting Settings with the Re-segment option 

Note: Image exports also support *.svg, *.wmf, and *.png image format.  

 

Figure 98: Plot export options 

● Export image series also opens the Plot Exporting Settings dialog, except that the segments 
are prepopulated with six equal sized segments. This simplifies the edits of the segments. The 
Add segment and Remove segment buttons control the number of segments that divide up 
the plot. 
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● Export all also opens the Plot Exporting Settings dialog, except that the wildtype peptide 
plots are exported along with the peptide plots. Segment editing functions are disabled for this 
option. 

● Export to CSV exports the plot trace x-y points to a *.csv file. 

● Copy to clipboard (all) enables pasting the plot image into another application. 

● Avoid label collision staggers the label text to reduce overlap. 

● Rendering options controls how a plot is displayed in the application. It includes several sub-
menus: 

 

Figure 99: Rendering options sub-menu 

o Preconfigured sub-menus control what is displayed in the plots. Default mode displays 
the trace, peak labels and plot title. Show all peak labels does exactly that. Trace only 
turns off the peak labels and plot title. 

o Show x grid lines turns on and off the x grid lines. 

o Show y grid lines turns on and off the y grid lines. 

o Show tracker displays a vertical dotted line that follows the cursor when moved in the 
plot. This allows a more precise determination of the X and Y positions of the cursor. 

o Y-tick label notation switches between display of Absolute y value (in scientific 
notation), Percent value, and Absolute (decimal) value (in decimal notation) as a 
function of the highest peak. 

o Adjust font sizes controls the font size for each type of text on the plot. 

o Plot styles allows changes to the graphic styling of the plot, including trace width, axis 
width, and total m/z dot colors to be used. 
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Figure 88: Adjust plot styles 

o Plot name: The last of the Rendering options sub-menus displays the sample names of 
each displayed trace. Hover over the sample name to see a deeper sub-menu of plot 
choices. The user can turn on and off the trace, graphical integrations and peak labels for 
that particular sample. The Show/hide all option turns all of these options on or off.  

● Show/hide sample name (XIC and Isotope plots only) controls whether to display the sample 
names or not for both individual and stacked plots. 

● Sample name position (XIC and Isotope plots only) reveals sub-menus to position the 
sample name with respect to the graphs. 

 

Figure 100: Sample name position options 

Trace Plot Menu 

The Trace plot menu bar includes the following specialized controls: 

● The  icon shows the options for managing baseline anchors. The Trace plot baseline has no 
effect on the neutral mass spectrum, only the areas of the trace peaks, so most users can 
ignore these options: 
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o The  icon moves the ends of a baseline anchor. Move the cursor to either end of the 
baseline to see the anchor displayed in green and the cursor changed to an arrow. Click, 
and drag the end of the baseline to the new location. 

 

Figure 101: Moving the baseline 

o The  icon inserts a new baseline anchor (polygon vertex). Move the cursor to the 
baseline to see the anchor displayed in green, as shown at the right, and the cursor 
changed to an arrow. Click anywhere within the baseline anchor to divide it into two parts 
at that point. The Move baseline anchor mode can be used to move the endpoints of the 
baseline anchors. 

o The  icon deletes a baseline anchor. Move the cursor to the end of the unwanted 
baseline to see the anchor displayed in green and the cursor changed to an arrow. Click 
to delete that baseline anchor. 

● The Center button pans the trace to put a selected peak in the center. 

● The Labels button opens the Template Editor for peak labels. The editor accepts free text or 
programmatic “short codes” that can place data into peak labels. 

● The slider to the right of the Label button changes the allowable distance of labels from 
reference points. Moving the slider to the right will display more labels that are further apart. 
Dotted lines connect the extra labels to their peaks. Moving the slider to the left will reduce the 
number and separation of the labels. For example, with the slider to the left, there can be label 
collision: 

 

Figure 102: Minimum label separation can hide or overlap labels 



Intact Analysis Manual v5.12                                          

51 

As the slider is moved to the right, more labels are shown, and they are spaced further apart: 

 

Figure 103: Increasing label separation shows more and clearer labels 

● Minutes/pI radio buttons appear when an electropherogram is loaded when using the icIEF-MS 
workflow. The user can change the X-axis unit label to Isoelectric point (pI): 

 

Figure 104: Electropherograms expose radio buttons to choose pI units 

The Trace plot includes the following specialized right-click menu: 

● Show/hide sample name displays or removes the labels from the staggered plots. 

● Sample name position opens a dialog to set label placement and alignment: 
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Figure 105: Sample name position 

By setting Vertical alignment to Above the curve, the sample name label for the bottom trace will be 
displayed correctly: 

 

Figure 106: Trace plot labels displayed below (left) and above the curve (right) 

● Labels opens the Template Editor, allowing the user to define the peak label: 

 

Figure 107: Template Editor for labels 

The editor accepts free text or programmatic “short code” 

Deconvolved Mass Spectrum Menu 

The Deconvolved Mass spectrum menu includes the single most important specialized control: the 
orange Compute button, which sets the parameters for the deconvolution. A click on this button opens the 
Intact options dialog: 
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Figure 108: Intact compute options Basic tab 

The Basic tab contains the primary deconvolution parameters. Mass range and m/z range set ranges for 
neutral masses and m/z, respectively. Min difference between mass peaks and Max number of mass 
peaks control peak picking. Peak sharpening deconvolves a “point spread function” to give super-resolved 
mass peaks and turn shoulders into separate peaks. Spread function width gives the halfwidth of the 
point spread function; a reasonable width is a little less than the square root of the peak mass in kilodaltons, 
for example a width of 10–12 for peaks in the 140–160 kDa range. We do not recommend peak sharpening 
for mass ranges wider than about 20,000 Da or for mass spectra with more than about 40,000 points. Thus, 
it is not advisable to use peak sharpening on a spectrum with mass range 140,000 to 160,000 with mass 
spacing (see below) of 0.2, but it would be okay if mass spacing is changed to 0.5.  

The most important parameter is the Mass range. The example in Figure 2 and Figure 3 at the beginning 
of the manual used a mass range of 146,000–150,000 Da, wide enough to include the major proteoforms 
of Adalimumab, but narrow enough to run quickly and achieve maximum sensitivity and resolution. The 
default mass range is 10,000–160,000 Da, which gives a wide survey of the ions in the m/z spectrum. A 
typical workflow starts with a wide range and then narrows the range to capture all the major proteoforms. 
Narrowing the range to capture only a single proteoform and exclude all the others is not recommended, 
unless the m/z range can also be narrowed to capture the single proteoform. Forcing essentially all the ions 
in the m/z range to map onto the mass range is a deliberate design choice: this design allows Intact Analysis 
to deconvolve spectra with low signal-to-noise ratio so long as the user has some prior knowledge of the 
protein’s intact mass. 

Noisy MS1 spectra tend to produce “furry” peaks at the low end of the mass range, due to chance ratio 
relations among noise peaks. Thus, extending the Mass range to lower masses (for example, using 5–30 
kDa for mAb subunits rather than 20–30 kDa) may improve the deconvolution of the masses of interest by 
moving the noise farther away. The Advanced configuration parameter MinPeakMass (see Appendix) can 
be used to exclude low-mass peaks from peak picking. 

The m/z range is less crucial than the m range, but best results will be obtained with a range that covers 
the signal and excludes the noise. The m/z range also constrains the color dots that are rendered on the 

MS1 plot when the selection marquee  is toggled. 
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If the MS1 spectrum contains two or more molecules with non-overlapping m/z ranges, for example, a full 
mAb at 150 kDa with signal at m/z 2000–3000, and a free light chain at 25 kDa with signal at m/z 1000–
2000, then the best detail will be obtained by performing multiple deconvolutions with different m/z and 
mass ranges. An initial survey deconvolution, along with inspection of peaks with colored dot peaks, will 
guide the mass and m/z ranges for the subsequent deconvolutions. PMI Intact Analysis has no set limits 
on mass, m/z, nor charge, and it has been used successfully on masses from 2 to 2000 kDa, m/z from 400 
to 20,000, and charges from 2 to 200. 

The Advanced options mainly concern resolution. You will need to use this tab if your aim is to produce 
isotopically resolved neutral mass spectra. 

 

Figure 109: Default Intact compute option Advanced tab values 

“Charge vectors” give the charge assignment probabilities for each small interval of m/z points. 
Deconvolutions of most MS1 spectra will be almost exactly the same with any Charge vectors spacing 
from 0.2 to 1 m/z units (Thomsons), but a narrow spacing of 0.1 may give better results on isotope-resolved 
MS1 spectra with interleaved signals, and a wide spacing of 2 may give better results for native MS with 
broad m/z peaks. 
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Figure 110: Intact compute option Advanced tab values to preserve monoisotopic resolution 

Intact Analysis removes an m/z baseline before deconvolution; this step and removal of charge-one or stop-
list peaks (see Appendix) are the only steps in the algorithm that do not conserve ions. Baseline radius 
controls the stiffness of the baseline. A baseline radius of 8 gives a flexible baseline that will cut into m/z 
peaks broader than 8 Thomsons; this will often give better visual separation of neutral mass peaks, but 
may distort peak areas. A baseline radius of 30 will give a stiffer baseline that cannot cut into m/z peaks 
narrower than 30 Thomsons. An even larger value, such as 100 or more, may be needed for native MS. 
The default value of 15 is a compromise. 

Spacing (m/z) controls the spacing of sample points in the m/z spectrum. The raw MS1 data is represented 
as a continuous piecewise-linear function that can support any spacing of sample points, but m/z spacing 
finer than the finest spacing in the original data will slow the computation without adding resolution. 
Reasonable values for Spacing (m/z) are in the range 0.005–0.05 for QTOF instruments, which have 
almost the same resolution at all m/z; the low setting of 0.005 would be appropriate for Bruker maXis and 
the higher setting of 0.05 for older instruments with lower resolution. For Orbitrap, the resolution depends 
upon m/z; the setting of 0.005 shown above is for isotope-resolved 25 kDa masses (antibody subunits). For 
native MS on Exactive EMR with m/z’s in the 5000–10,000 range, a spacing of 0.1 is fine enough. 
Smoothing sigma (m/z) is typically set to the same value as Spacing (m/z), but a larger value can be 
helpful for producing an appropriately smoothed neutral mass spectrum with less smoothing at lower mass 
and more smoothing at higher mass. 

Mass spacing controls the spacing of points in the neutral mass spectrum. To preserve isotopic resolution, 
spacing should be set to 0.1 or even 0.05. If the MS1 spectrum does not have isotopic resolution, or isotopic 
resolution is not needed for analysis, mass spacing in the range 0.2 to 1 is best for target molecules below 
200 kDa. Spacing of 10 Da or more is best for targets above 300 kDa. For mass spectra without isotopic 
resolution, Mass smoothing sigma in the range of 2–5 will smooth jittery peaks in the range 20–200 kDa; 
larger values will be needed for larger masses. For mass spectra with isotopic resolution 0.1 will work. 



Intact Analysis Manual v5.12                                          

56 

Iteration max set to 10 will work for most purposes. A larger value, say 20 or 30, can be helpful for lower 
signal-to-noise spectra that take longer to converge. 

Charge range is best set to a wide range, in which case the charge range will be implied by the mass and 
m/z ranges. The example in Figure 2 and Figure 3 has m/z range 2200–4000 and m range 146,000–
150,000, so the charge range spans 36 (146,000 / 4000) to 68 (150,000 / 2200). The default range of 5–
100 covers most applications, but 5 will need to be reduced for deconvolutions with mass range starting 
below 10 kDa, and 100 increased for targets that may have charges above 100. 

Peak sharpening uses the Spread function width set in the Basic tab to deconvolve the data. The 
Advanced tab offers three infrequently used controls for peak sharpening. Blur skewness controls the 
asymmetry of the point spread function; the default value of 1.1 means that the right tail has sigma (standard 
deviation) 10% bigger than the left tail. 1.2 gives even more tailing; 1.0 gives a symmetric point spread 
function. Range sets the length of the tails in standard deviations; a small value of 5 or 6 may work better 
in the case of Lorentzian point spread. Blur type has two choices: Gaussian (skinny tails) and Lorentzian 
(fat tails). Lorentzian should use a slightly smaller sigma than Gaussian. 

After the deconvolution settings are modified, click Save and Compute. For difficult data, you may need to 
explore the space of settings to obtain the best deconvolution. As a general rule, correct deconvolutions 
are stable under changes of parameters. If a neutral mass peak appears with a specific mass range setting, 
but disappears when the settings are varied, the peak may be an artifact. 

The Deconvolve Mass spectrum view includes another very important specialized menu: the Toggle 

selection marquee  icon. A click on this icon sets the cursor to selection mode. When a picked peak is 
clicked in the plot, a colored dot appears over that peak (Figure 105) and the same-colored dots appear 
over the corresponding peaks in the MS1 view (Figure 106). Click on top of another deconvolved peak to 
assign a different colored dot to that peak and its MS1 peaks. The colored dots in the MS1 spectrum are 
the best way to tell true mass peaks from artifacts; the MS1 dots for true mass peaks have contiguous 
charges and tend to hit local maxima for m/z intensity. 

 

Figure 111: Deconvolved Mass spectrum peaks marked with colored dots in selection marquee mode 
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Figure 112: Corresponding peaks in MS1 plot are marked by the same colored dots 

The m/z range settings in Intact options dialog, opened by a click on the orange Compute button will 
constrain the rendering of the colored dots in the MS1 plot. 

Dragging the cursor over a rectangular area of the plot selects all the picked peaks in that area. Dragging 
the cursor while holding down shift adds more selections without losing current selections. Click outside the 
peaks to remove all colored dots. 

A second click on a selected mass peak will open a dialog box to assign the peak; this allows the user to 
add a name to the peak and to make the peak persistent. 

When the  icon is clicked again to turn off the selection mode, peak selections remain. The cursor can 
now be used to zoom without affecting the peak selections. Peaks can also be selected by selecting rows 
in the Masses table as explained above. Shift-click and control-click can be used to select multiple rows in 
the Masses table. 

Mass XIC 

The Mass XIC plot can be enabled by selecting Enable Mass XIC in the Window drop-down. Once 
enabled, an additional view is added to the project, as shown below: 
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Figure 113: Mass XIC view 

The Mass XIC feature allows the user to quickly assess the elution profile of deconvolved species using a 
sophisticated Mass XIC algorithm to accurately represent the elution profile of a target molecule. It can 
suppress interfering isobaric charge states and preserve the actual target elution profile. To view Mass 
XIC, simply select MS1 target mass and observe the population of the Mass XIC plot. The default mass 
extraction width is set to 20 ppm. The actual mass range is reflected in the title if the protein name is not 
provided. The color of the plot matches the color of the dot on deconvolved mass plot. Multiple selections 
of target masses result in multiple Mass XIC plots stacked in the Mass XIC plot.  

 

Figure 114: Stacked Mass XIC plots 

To control the distance between plots, use the Offset control above the Mass XIC plot.  

 

Figure 115: Mass XIC offset control 

Mass XIC plot labeling can be customized within the Template Editor, which can be accessed by opening 
Plot Settings > Labels > Edit Annotations. From there, the user can enter an HTML script to customize 
labels as desired.  
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Figure 116: Labeling Mass XIC plot in Template Editor 

Appendix 

Intact Analysis: Advanced Commands 

Intact Analysis facilitates quick and accurate deconvolution of intact mass spectra and automatic 
assignment and annotation of the resulting spectra. However, there are many ways to customize the 
processing to fit specific needs. This section describes several text-format Advanced Commands that will 
enable finer control over processing. Protein Metrics uses Advanced Commands to test new ideas, beta-
test new features, and enable specialized options, without adding complexity to the graphical user interface. 

Introduction 

Intact Analysis Advanced commands control deconvolution, mass peak selection, mass calculation, 
annotation, and reporting. These commands are preceded by the entry [Intact] to identify them as control 
commands. Spaces between the command text and values do not affect processing (text=1 or text = 1 are 
equivalent). Advanced commands may be entered during project creation in the Advanced configuration 
panel of the Advanced tab or after project creation by selecting Edit -> Advanced configuration. 

Peak Detection and Assignment 

1. Automatic Assignment of Reference Masses assign reference masses from Protein or 
Sample-protein input even if there are no detectable peaks at the reference masses. 

[Intact] 

ForceShowMassesOfInterest = 1 

 

2. Stop List removes unwanted signals from the spectra before processing. For example, the user 
may wish to remove intense calibration ions. The list consists of m/z values used to remove 
signal from the MS1 data before deconvolution. The example below shows removal of m/z peaks 
from Agilent tuning mix. 
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o UseStopList – This enables or disables the use of the Stop List. 

o StopList – This identifies the m/z values of signals to remove. 

o StopTolerance – This sets the m/z interval used for matching peaks on the StopList. 

[Intact] 

UseStopList = 1 

StopTolerance = 0.1 

StopList = 622.02896, 623.032, 922.009798, 923.012, 

1221.990637, 1222.993, 1521.,971475, 1522.974, 

1821.952313, 1822.955, 2121.933152, 2122.936 

 

3. Remove Singly Charged Peaks allows the user to remove singly charged peaks with m/z 
(maximum 2500). For example, a value of 0.02 directs the software to remove singly charged 
peaks down to 2% of base peak. 

[Intact] 

RemoveChargeOne=0.02 

 

4. Isotope Peak Spacing directs the software to use isotope peak spacing (as well as multiple 
charge states) to determine charge for ions with charge up to the input number (maximum of 12). 

o IsotopeSpacing helps the deconvolution whenever peaks are isotope resolved and do not 
appear in 3 or more charge states. 

o IsotopeSpacingThreshold sets an intensity threshold. A value of 0.05 limits isotope 
spacing to peaks down to 5% of base peak. The default is 10% of base peak. 

[Intact] 

IsotopeSpacing=5 

IsotopeSpacingThreshold=0.05 

 

5. Monoisotopic Mass directs the software to compute monoisotopic mass using a protein 
averagine model for mass peaks up to the set MaxMonoisotope value. This command should be 
used in conjunction with convolution parameters that support isotopic resolution (for example, m/z 
spacing of 0.01 Thomsons and mass spacing 0.1 Da, with similarly small smoothing sigmas). 
However, the software will fit the averagine model whether or not the mass peak has isotopic 
resolution. 

[Intact] 

MaxMonoisotope=30000 

 

6. Show Observed Mono shows orange diamonds at the observed monoisotopic mass on the 
Deconvolved Mass Spectrum plot 

[Intact] 

ShowObservedMono=true 

 

7. Known Mass Deltas assigns known mass differences. For example, a mass of 162.1 can be 
assigned to glycosylation or the drug mass for antibody-drug conjugates (ADCs), to help 
determine charge of m/z peaks.  

CombFilter counts the number of KnownMassDelta to the left and the right. A value of 1 is suitable 

for glycosylation and ADCs. A larger value, for example, CombFilter=3, is appropriate for targets 

with long chains of equally spaced masses, such as nanodisks or PEGylated proteins. Excessively 

large values may cause artifacts. 

[Intact] 
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KnownMassDelta=162.1 

KnownMassDelta2=111.1 

KnownMassDelta3=222.2 

CombFilter=1 

 

8. Noise Level controls the minimum signal-to-noise ratio of a picked peak in the neutral mass 
spectrum. Use of EnableBaselineRemoval (see below) improves the signal-to-noise ratio, so 
there may be no need to adjust NoisePercentileFactor. 

o NoisePercentileFactor sets the minimum signal-to-noise ratio (amplitude of mass peak 
relative to amplitude of background noise peaks – see below) for picked mass peaks. A 
low value such as 2 will pick peaks barely above the noise; a high value such as 10 will 
pick only clear peaks. 

o NoiseSigmaFraction is the fraction of mass bins assumed to contain only background 
noise. For example, a value of 0.25 indicates that at least 25% of the mass bins in the 
neutral mass spectrum are assumed to be without signal peaks. There should be no need 
to adjust this parameter unless the mass spectrum is extremely crowded with true masses. 

[Intact] 

NoisePercentileFactor = 4 

NoiseSigmaFraction = 0.25 

 

9. Baseline Removal enables baseline removal in the neutral mass spectrum.  

o EnableBaselineRemoval – Set this to 1 to enable baseline removal from the m spectrum. 

o BaselineRemovalFraction is the fraction of mass bins assumed to contain only 
background noise. In almost all neutral mass spectra, peaks occupy less than 80% of the 
mass bins so any value from 0.05 to 0.2 should give similar results. 

[Intact] 

EnableBaselineRemoval = 1 

BaselineRemovalFraction = 0.05 

 

In the Deconvolved Mass spectrum, baseline removal is controlled by Baseline radius 
(m/z) in the Advanced tab of the Compute button. 
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Figure 117: Baseline radius in Compute options Advanced tab 

10. Peak Picking is a group of commands that allow greater control over which peaks in the neutral 
mass spectrum are picked for labeling, colored dots, automatic matching, etc. 

o PeakDetectorWidth –sets the peak width (half width half height) used by the Intact 
Analysis “matched filter” to pick peaks in the mass spectrum. By default, 
PeakDetectorWidth is one-third of the minimum difference between mass peaks, set on 
the Basic tab of the deconvolution parameters. A PeakDetectorWidth value of 5, implied by 
the default value of 15 for “Min difference between mass peaks”, will work well for a wide 
mass range such as 10,000–160,000. Too wide a setting will pull the picked peak off the 
visual apex in the case of asymmetric peaks. Too narrow a setting will pick up jitter on top 
of jagged peaks. A very large number (for example, 500) can be used to pick just one 
representative peak for a peak series. This is useful for antibody-drug conjugates with the 
same number of drugs but varying glycosylation and dead-end linkers. A 
PeakDetectorWidth of 5 also works well for picking the isotope peak closest to the 
average-isotope mass for isotopically resolved mass peaks, but this width may sometimes 
pick a gap between isotopes. 

[Intact] 

PeakDetectorWidth = 5 

 

o MinPeakMass excludes peaks with masses below the set minimum. For example, the 
user can deconvolve over a mass range of 6000 - 200,000, but only ask for picked peaks 
with masses > 20,000. Deconvolving over a wider range can clean up noisy spectra, 
because noise peaks tend to concentrate at the low end of the mass range. Similarly, 
MaxPeakMass excludes peaks with masses above the set maximum. If not specified, 
MinPeakMass and MaxPeakMass span the same range as the mass range for 
deconvolution. 

[Intact] 

MinPeakMass = 20000 

MaxPeakMass = 150000 

 

o MinBasePeakRatio excludes peaks which are less than the set fraction of the intensity of 
the tallest peak in the range [MinPeakMass, MaxPeakMass]. By default, 
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MinBasePeakRatio=0. For example, a value of 0.05 excludes peaks that are less than 5% 
of the tallest peak in the range. 

[Intact] 

MinBasePeakRatio = 0.05 

 

11. Antibody Clip Naming names the antibodies for the clips, by default. Setting this to 0 turns off 
this feature and prevents multiple recalculations of the clips. 

[Intact] 

DoAntibodySpecificClipsAndNames=0 

 

12. Insert Anchors injects manual baseline points when the baseline smoothing parameter alone is 
inadequate. This will help to keep big dips out of the calculated area if points just outside the time 
range are included, as depicted below: 

[Baseline] 

InsertAnchors=19.27,20.12 

 

 

Figure 118: Insert baseline anchors 

Note that this function requires the user to have knowledge of where to place the baseline points. The 
values 19.27 and 20.12 were observed from the chromatogram. 

13. Mass charge vector improves charge distribution modeling for native MS.   

o This command is especially important for native-MS spectra that contain both monomers 
and dimers, or large homo-multimers. 

o The command assumes that larger masses appear at higher average m/z, that is, average 
charge scales less than linearly with mass. 

o "MassCharge=1" is recommended for native MS. This setting assumes that a homodimer 
will tend to have less than twice the charge of the monomer, so that its charge distribution 
is centered at higher m/z.  This assumption does not always hold for denatured proteins, 
for example, an antibody heavy chain may hold more than twice the charge of antibody 
light chain. In this case, "MassCharge=1" will not give an accurate deconvolution. 

[Intact] 

MassCharge = 1 

 

o "CheckDoubleMass=1" is another advanced command that will help with masses in 1:2 
ratio. This command does not make the assumption stated above, so it may work when 
"MassCharge=1" does not. It is recommended to use either "CheckDoubleMass" or 
"MassCharge", but not both at once. 

[Intact] 

CheckDoubleMass = 1 
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14. Non-uniform stepping for improved deconvolution 

Previous versions of Intact Mass used uniformly spaced points in both the m/z and m spectra, with the 
point spacing controlled by “Spacing (m/z)” and “Mass spacing” in the Advanced section of the 
Compute menu in the Deconvolved Mass plot.    

The user now has an option to use nonuniform point spacing for both the m/z and m spectra using the 
advanced command below. 

[Intact] 

SteppingMethod=Linear 

MZResolution=35000 

 

SteppingMethod has 3 different settings:  Linear, SquareRoot or Constant.  

o Constant setting is the default value for backward compatibility and uses “Spacing (m/z)” 
and “Mass spacing” to define constant stepping in m/z and mass domains respectively. As 
before, it is important to set “Spacing (m/z)” at least 10 times smaller than “Mass spacing” 
to prevent possible moiré effects in the deconvolved spectrum.  

o Linear stepping frees the user from making the sometimes-difficult choice of uniform 
spacing parameters. MZResolution is unitless and is defined as the ratio of m/z to FWHM 
peak width. MZResolution set to 35000 gives good results for most high-resolution TOF 
and Orbitrap data. (The resolution setting for Orbitrap data acquisition refers to resolution 
at m/z 400, which will be about twice the actual resolution at 1500.) The internal sampling 
rate is set to 5 points across the FWHM of a single peak; this means that 
MZResolution=35000 has spacing of 0.02 (= (3500/35000) / 5) at m/z 3500, spacing of 
0.04 at m/z 7000, and spacing of 0.01 at 1750.   

o SquareRoot stepping simulates TOF instrument point spacing. In this case, MZResolution 
is applied at the middle of the spectrum; SquareRoot may cause some under- and over-
sampling. 

15. IsotopeEnvelopeFilter for increased resolution for isotopically resolved data 

IsotopeEnvelopeFilter reduces the spurious peaks in the m spectrum. Peaks are considered 
spurious if they do not exhibit the expected “averagine” isotope envelope: either isotope resolved 
or almost isotope resolved. At high masses, peak shape is often determined by instrument 
resolution or adducts rather than isotopes. Isotope envelope filtering is especially effective at 
removing artifact m peaks resulting from charge-one m/z peaks. 

[Intact] 

IsotopeEnvelopeFilter=true 

 

16. ChargeEnvelopeFilterPower2 for Increased Sensitivity and Dynamic Range 

ChargeEnvelopeFilterPower2 offers more sensitive deconvoluted m spectra as compared to 
previous releases. For low signal-to-noise proteoforms with many charge states, the new 
algorithm can improve Limit of Detection (LoD) more than 10-fold.  

[Intact] 

ChargeEnvelopeFilterPower2=true 

 

The default charge envelope weights will work well for masses with at least 5 or 6 charge states. 
For spectra in which masses tend to have fewer charges, for example, native MS spectra, the 
user can change the weights:  

[Intact] 

ChargeEnvelopeWeights=0.1, 0.8, 0.1 
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The total number of these weights must be odd, and they must be normalized to sum to one. For 
example, weights of 0.05, 0.9, and 0.05 assume less charge spread than 0.1, 0.8, 0.1. 

17. AdvancedMonoCalculation for improved monoisotopic mass calculation 

Deconvolved isotope series may get slightly distorted by one or more signal interference events 
at specific charge states, especially for larger masses. This might result in monoisotopic mass 
calling errors. A new advanced command AdvancedMonoCalculation, which improves the 
monoisotopic mass calculation, is now available. The new advanced command will use both the 
deconvolved mass spectrum and the original MS1 spectrum to make the monoisotopic mass 
calls. Using MS1 spectrum improves the monoisotopic mass calls, given that there are many 
isotope envelopes (corresponding to different charge states) from which a reliable statistic can be 
derived.  

[Intact] 

AdvancedMonoCalculation=true 

 

18. Ability to select scan type (MS1, MS2, or both) and mass range  

The ability to select the scan type (MS1, MS2, or both) as well as the scan range (if there are 
multiple scans of one type) is activated through the advanced commands: 

[MSReader] 

MSLevelSelection=1 

MSFilterMZRange=[150-2000] 

[MSReader] 

MSLevelSelection=2 

MSFilterMZRange=[150-2000]   

 

19. Auto label deconvolved peaks with overlapping isotopic envelopes  

The following advanced configuration parameter can now be used to better resolve peaks with 
overlapping isotopic envelopes: 

[Intact] 

ExtraSmoothingForCentroid=false 

When ExtraSmoothingForCentroid=false (default), provided Min difference between mass 
peaks (Da) is set to <5 Da, single isotope peak resolution in a deconvolved signal can be 
achieved.  

The legacy behavior (versions 4.4 or earlier) can still be achieved with the following advanced 
configuration:  

[Intact] 

ExtraSmoothingForCentroid=true 

20. Smarter matching of larger masses 

A new advanced command for enabling the masses recalibration (for larger masses) before the 
match is added to Intact Analysis. A supporting feature to show the new calibration values is also 
implemented. 

[Intact] 

RecalibrateMasses=true 

ShowMassRecalibrationColumn=true 

 

With RecalibrateMasses=true, the mass matcher runs two times. The first run uses a double 
tolerance value to select only the very high-intensity peaks (>= 20% of the most intensity in the 
plot) to be used as a calibration reference. After creating a calibration function, the mass matcher 
runs again with calibrated masses and configured tolerance. The RecalibrateMasses advanced 
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command does not change the masses in the table or on the plot, it just changes the matching 
criteria.  

 

In addition to the RecalibrateMasses, if the advanced command  
ShowMassRecalibrationColumn=true 
is used, then the software will show the recalibration correction to be added to the measured 
mass before comparing to the theoretical mass. 

21. Auto Mass Range Computation 

[Intact] 

MassPadding=2000 

MassRangeInputMassFractio=0.02 

MassRangeIntensityFraction=0.9 

 

22. Speed up MS1 scan summing by reducing the .cache file size 

[Intact] 

MzSampleSpacing=0.01 

 

By default, Intact Mass resamples the data at a fixed m/z spacing, which has a default value of 0.005, 
and .cache files are built with this default value in order to speed up MS1 scan summing. This 
may be too coarse for some data (e.g. R=120,000 and peaks < 1000 m/z), but too fine for other 
data. You can change the spacing with the MzSampleSpacing advanced command.  Mainly used 
to reduce the .cache file size. 

23. MinMzPeakSpacing=25 tells the software that m/z peaks in a charge series cannot be spaced 

any closer than 25 apart. Peak spacing is proportional to m/z2 so this sets a charge limit of about 

77 on a mass of 150,000, because 25 ≈ 150,000 / 772. This limit, prevents the full antibodies 

from claiming low mass peaks. MaxMzPeakSpacing=65 prevents the half antibodies from 

claiming full antibody peaks; though this error does not usually occur, because the full antibody 

has peaks (the odd charge peaks) that cannot be claimed by the half antibody 

[Intact] 

MinMzPeakSpacing=25 

MaxMzPeakSpacing=65 

UseMzSpacing=1 

24. Fragment ion intensity is now taken into account for MS2 fragment scoring  

As of Byos v5.6, when MSMS fragments are available, the software is now able to use the 
intensities of the fragments to add validity to the scoring. 

The scoring can be evaluated during MS2 annotation process by checking “Score fragments“ option 
in MS2 annotation options and setting a desired score threshold for ion annotations.  

The default score cutoff is 10.  A different score cutoff can be set under the Advanced settings 
during Project Creation, affecting all MS2 scores in the table. 

[MS2] 

FragmentScoreThreshold=10 

 

 

When applied, the scores will be displayed and the cutoff applied during scoring and MS2 
annotation. Users can change this within the MS2 annotation options. 
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Intensity plays significant role in scores if otherwise desirable isotope patterns are observed in 
conjunction with low scores due to a lower intensity advanced parameter. The following advanced 
command can be used to turn off intensity consideration: 

[MS2] 

IntegrateSNIntoFragmentScore=false 

 

 

To switch to the original method of fragment isotope scoring, the following advanced parameter 
can be used: 

[MS2] 

FragmentMatchScoringMethod=KL 

 

25. New advanced commands available to apply default commands suitable for Native, 
Denatured, and Isotopically resolved data 

New, simple advanced commands are available as of release v5.8 which allow users to apply 
default commands relevant to Native, Denatured, and Isotopically resolved data. 

 

[Intact] 

Mode=Native 

[Intact 

Mode=Denatured 

[Intact] 

Mode=IsoResolved 

 

26. The following advanced command is now available as an option to filter progressive 
deconvolution results: 

[Intact] 

MinConsecutiveObservations = 3 

 

with 3 being the default value.  

Rendering 

1. ShowMSLabelDots, when set to false, hides the dots for the MS1 and deconvolved mass plots. 
Setting ShowChromLabelDots to false hides the dots for the Trace plots: 

[Rendering] 

ShowMSLabelDots=false 

ShowChromLabelDots=false 
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Figure 119: Plots with the dots hidden 

These functions are set to true by default. 

2. Label Density in Plots - adjusts the density/count of labels for plots by the highest peaks. The 
default value is 1. The minimum value is 0.01; smaller values will be treated as 0.01. The 
maximum value is 10; larger values will be treated as 10. Note: it is not recommended to set the 
label density factor below 1. 

[Intact] 

DeconvolutionPlotLabelFactor=1 

MS1PlotLabelFactor=0.01 

ChromatogramPlotLabelFactor=3 

 

Additionally, LabelFactor sets the density for all plot types to the same value. 

Example displays for label densities: 

 

Figure 120: LabelFactor = 1 (default) 

 

Figure 121: LabelFactor = 0.01 (minimum setting) 

 

Figure 122: LabelFactor = 3 

3. Trace plot annotations – can be modified for maximum values in table columns. By default, the 
Trace plot annotations report the peak number and the name of the most abundant mass. This is 
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represented by the annotation script access by opening Rendering options and clicking Edit 
annotations:  

PeaksDynamicNumber] - <script>max('[ApexPositIntensity]', 

'[Sequence]')</script> 

The Trace plot uses this setting to display the most abundant mass name for each peak: 

 

Figure 123: Default Trace plot annotations using most abundant mass 

The max function can be used for other annotation labels, for example: 

o <script>max('[ApexPositIntensity]')</script> returns the maximum value of 

the Intensity column 

o <script>max('[ApexPositIntensity]', '[Sequence]')</script> returns the 

value of the Name column for which Intensity is maximum 

o <script>max('[ApexPositIntensity]', '[Sequence], 

[ProteinAccessionName]')</script> returns the value of the Name column and 

Protein Name column for which Intensity is maximum 

4. HideLabelsIfCollision controls whether labels are hidden in the case of label collisions (the 
default setting is true): 

[Plot] 

HideLabelsIfCollision = true 

 

5. ShowLabelsFromTopStackedPlot will enable peak annotation only for the top stacked plot: 

[DMS] 

ShowLabelsFromTopStackedPlot=True 

 

6. Improved visualization of multiple traces 

The advanced command StartupSelectAllTraces=true will override the default behavior, which shows 
only a single trace. Instead, all the traces that are checked at project creation will be shown after 
the project is successfully created. 
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[Project] 

StartupSelectAllTraces=true 

 

 

Reporting 

1. MassNameTemplate customizes the Name column in the Masses table of Intact Analysis to 
meet user needs. The display may be configured to show any text along with data from any of the 
following five fields: 

[ReferenceName] = The reference mass name 

[DeltaName] = Matching delta mass name 

[ExpectationType] = Desired, Undesired, Unexpected, Ignored 

[ExpectedMass] = Sum of reference and delta mass value 

[ObservedMass] = The deconvoluted mass value -- for example, the following definition: 

[Intact] 

MassNameTemplate = [ReferenceName], [DeltaName] / 

[ExpectedMass] 

 

Would give the following output mass peak name: HC, G0F / 1234.123 

As a second example, assume theMassNameTemplate is defined as follows: 

[Intact]  

MassNameTemplate=rn:[ReferenceName] dn:[DeltaName] 

et:[ExpectationType] em:[ExpectedMass] om:[ObservedMass] 

 

The matched masses (light and heavy chains of an antibody) receive the names as shown below: 

 

Figure 124: Named masses with the MassNameTemplate 

2. EnableValidateOverride allows manual control over the Status setting. The Traffic Light view 
displays the status of Desired, Undesired, and Unexpected counts, but sometimes the user would 
like to manually change the Pass / Fail value in the Status column based on the value from 
Validate column. This is possible if the Validate column is not empty and the new Advanced 
configuration detailed below is enabled: 

[Intact] 

EnableValidateOverride = 1 
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Figure 125: Setting Pass/Fail values in the Project table Status column 

Intact Reconstruction 

One challenge in analytical chemistry is the need to compare orthogonal methods in a systematic fashion. 
The following are steps to reconstruct Intact mass spectra of proteins from peptide mapping data. Protein 
degradations at the amino acid level quantified by peptide mapping methods are convolved against each 
other to reconstruct a theoretical Intact mass spectrum. Comparing the theoretically reconstructed Intact 
mass spectrum against the experimental spectrum provides a way to compare peptide mapping data 
against Intact mass spectrometric analysis. The differences between the two spectra can then be used to 
compare how well each method correlates with the other. This can then be used to adjust acquisition or 
data analysis settings accordingly.  

As of Byos version 5.4, a new multi-node workflow is available for Intact Reconstruction using Byonic, 
Byologic, and Intact Deconvolution.  

1. Within Project Creation within the workflow, users should add a Peptide and Intact raw data file.  
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Figure 126: Add Intact and Peptide files to the workflow 

2. Load FASTA sequences within the Sequences and masses tab 

 

Figure 127: Load FASTA sequences 

3. Three entries should be created under Sequence combinations: One single LC, one single HC, 
and one entry containing two of each chain. 
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Figure 128: Create three sequence combinations 

4. Under the Processing Node tabs, ensure that your Samples in each node are pointing to the 
appropriate Peptide and Intact samples, specifying the Peptide sample name for the Byonic and 
Byologic nodes and the Intact sample name for the Intact node.  

 

Figure 129: Specify samples per node 

5. Ensure that the Report configuration path is pointing to Blgc_reconstruction_export.rptc. for 
the Byologic and Intact nodes.  

6. After running this workflow, two projects will be created, one .blgc and one .ntms (along with a 
report for the .blgc). The report for the .blgc project should look like the following:  
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Figure 130: Generate Byologic report 

7. Export the pivot table content (CSV) from the second tab  

 

Figure 131: Export second tab as CSV 

8. Load this CSV file into the Reconstruction tool within the Intact project inspection view by clicking 
on the Reconstruction mass button and then Add CSV import as shown in order in the figure 
below. The table should populate: 
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Figure 132: Load CSV into new Intact project 

Intact Analysis Processing – Intact Reconstruction (Legacy Method) 

1. Open Byos and launch the Intact or Reduced workflow depending on the sample 
treatment.  

2. Drag and drop raw data files into the Samples table of the Samples tab.  

3. Drag and drop the relevant *.fasta file into the Chains table of the Sequences and masses 
tab and select the desired proteins. Note that the Protein name must be consistent between 
Intact Analysis and the *.csv file used for reconstruction. It may be easiest to build a *.fasta 
file with simple protein names like “HC” and “LC” in the case of mAbs. 

Depending on how you analyzed peptide data, you may have to turn off Q🡪PyroQ conversion 
in the sequence to mass calculation. If you used pyroQ as variable mod, uncheck the 
below box.  

 

Figure 133: Mass computation options 

4. Click Create Project and wait for the project to open. 

5. Click the Reconstruction mass button in the Deconvolved Mass Spectrum pane to 
access the Reconstruction table: 
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Figure 134: Reconstruction mass button 

6. Click Add CSV import and import the reconstruction CSV file you created.  The CSV file 
can be created manually or exported from the Peptide Analysis workflows. See the next 
section on how to export this table from Peptide Analysis automatically.  

 

Figure 135: Import the CSV file exported from the processing completed in Peptide Analysis 

7. Curate the list if required – rows may be edited, appended, or deleted: 
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Figure 136: Reconstruction table 

Click Add row to build a “Protein Target”. To add another parent row, click outside of existing rows and 
click Add row. To add a child row, click within an existing row and click Add row. Click the arrow 
to expose the associated child row. More child rows can be added by selecting the parent row 
and clicking Add row again. Please note only the child row can be edited.  

 

Figure 137: Building protein targets. 

Parameters: 

o Protein Name: Name of the Protein  

o Protein Count: How many chains per protein name (See figure 14 for an example) 

o Gauss Width: Width of reconstruction peak, i.e., instrument resolution 



Intact Analysis Manual v5.12                                          

78 

o Mass Offset: Used to shift reconstruction if calibration is off, i.e., a value of -1 will shift the 
reconstruction to the left by 1 Da. 

These settings will result in three reconstructions displayed in Intact Analysis as detailed below (HC, LC, 
and intact mAb): 

 

Figure 138: Protein Target input to result in three reconstructions, HC, LC, and intact mAb 

8. Click OK when the Protein Targets are set as desired. An example Reconstruction result 
is shown below: 

 

Figure 139: Final result — Intact reconstruction from peptide mapping data. The experimental Intact 
deconvolution is shown in black, and the theoretical reconstruction in blue. 
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Peptide Analysis Processing – CSV file generation (Legacy Method) 

This section is optional. A CSV file is required as input to generate Intact reconstruction in the Intact 
analysis. This CSV file can be created manually by the user (using Excel, for example), or it can be 
exported from a Peptide Analysis project. Below are instructions on how to export from Peptide 
Analysis reports. 

1. Filter out all method-induced modifications from the Peptide Analysis project. For example: 

 

Figure 140: Filters Editor 

Hint: Use the Presets button to save&load filters. 

2. Click the Report  icon to generate the associated report. 

3. Choose File > Presets > Report Presets > Blgc_IntactReconstruction.rptc 

4. Inspect all tabs to decide which modifications to include.  

5. Export the PTMs tab to *.csv since it will have majority of the modifications to reconstruct. 
Choose File > Export > Export pivot table content (CSV): 

 

Figure 141: Export the content from the pivot table 

6. Review and curate the list.  

7. Format the *.csv file, using the following requirements: 
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a. Only one sample should be exported at a time. Delete the % columns for the other 
samples. 

b. Delete the Sequence column. Delete the pivoted headers. The *.csv file should contain 
no more than four columns and one header row.  

c. Rename the remaining column headers to Protein, Position, Mod, and 
ModificationPercent. Note that these are case sensitive.  

d. In the Protein column, the names must be consistent between the *.csv file, Intact 
Analysis, and Peptide Analysis. It may be easiest to create a new *.fasta file to be used 
across all programs with simple names like “HC” and “LC” in place of mAbs. 

e. If the *.csv file must be appended with modifications from other tabs, the format for the 
Mod column should be: 

{text}/{delta mass}  

as shown in line 38 in the figure below, which was added manually. 

f. The Position value does not need to be a number. Position values may be duplicated, 
for example, residues like methionine can be mono- and di-oxidized. However, the total 
modification on a position may not exceed 100%.  

g. Here’s an example CSV file:  

 

Figure 142: Example exported CSV file 

 


